
Allererste Schritte mit   Quickfield 5.3 für 
Magnetfeldberechung im Frequenzbereich

Ziel der Reihe „allererste Schritte“ ist es, den Einstieg in ein bestimmtes Thema zu beschleunigen.

Michael Tuchscherer © 2009

Um was geht es?
Quickfield kann zweidimensionale physikalische Felder mit der Finite Elemente Methode 
berechnen. Die Studentenversion kann 255 Elemente (Dreiecke) simulieren.

Die Art der Felder kann unterschiedlich sein:
• Mechanische Dehnung, Verschiebung usw.
• elektrische und magnetsiche Felder
• thermische Ausgleichsvorgänge

In diesem Text wird die Simulation von Magnetfeldern im Frequenzbereich behandelt, wie sie 
z.B. in Transformatoren vorkommen. Dabei werden sowohl Magnetfelder als auch 
Stromdichtefelder berechnet. Kenntnisse über die grundsätzliche Bedienung des Programms (z.B. 
Zeichnen einer Geometrie und Zuweisen von Eigenschaften zu Geometrieelementen)  werden 
vorausgesetzt und nur kurz angesprochen.

Verwendete Installation
Die vom Autor verwendete Version für Windows:

Download unter: http://www.tera-analysis.com
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Trafo ohne Luftspalt
Für dieses Dokument wird ein einfacher Trafo (mit einem Ferritkern, der näherungweise wie ein 
Pot Core oder RM Kern aufgebaut ist) simuliert. Die Wicklung besteht aus Kupferband und hat 
primär und sekundär eine Windung. Primär wird ein Wechselstrom eingeprägt, die 
Sekundärwindung ist kurzgeschlossen.  Diese Konfiguration entspricht näherungsweise einem 
Netztrafo, oder einem Flusswandlertrafo. Die Entsprechung ist näherungsweise, weil in der realen 
Anwendung die Sekundärseite nicht kurzgeschlossen ist sondern gegen eine Last arbeitet.  (Das 
Beispiel befindet sich in Trafo1.pbm)

Neues „Problem“ beginnen
 (Mit „Problem“ wird in QF ein Projekt bezeichnet)

• File -> New -> Quickfield Problem
• Name des Projekts angeben
• Typ des Projekts: AC Magnetics

AC Magnetics bedeutet, das die Simulation mit sinusförmigem Wechselstrom durchgeführt wird.

Die weiteren Einstellungen können später noch geändert werden.
• Problem -> ... Properties
• Frequenzy = 100Hz

Da das Programm nur zweidimensionale Felder berechnen kann, gibt es 2 Möglichkeiten 
dreidimensionale Geometrien zu simulieren: 

plane parallel: Die Ebene in der gerechnet wird, ist ein Schnitt durch eine Geometrie, die sich 
oberhalb und unterhalb der Ebene unbegrenzt fortsetzt.

Axisymmetric: Die Ebene ist ein Schnitt durch eine rotationssymetrische Geometrie. Die 
Rotationsachse ist horizontal (also die x-Achse) 

Da ein Pot Core näherungsweise ein Zylinder ist, wird die rotationssymetrische Geometrie gewählt.

Abbildung 1: Die verwendete  
Geometrie



Abbildung 1 zeigt die obere Hälfte des Schnitts durch den rotationssymetrischen Trafo. Zusätzlich 
wurde eine vertikale Symmetrielinie eingefügt, an der das Feld gespiegelt wird. Es wird also nur 
eine halbe Kernhälfte des PotCores simuliert, da die andere Hälfte spiegelsymetrisch zu dieser ist. 
Dieses Vorgehen verdoppelt die geometrische Auflösung des auf 255 Elementen begrenzten Netzes. 
Insgesamt wird nur ein Viertel des gesamten Kernquerschnitts simuliert, da die unter der 
Rotationsachse liegenden Teile automatisch (ohne das sie gezeichnet werden müsen) mit 
berücksichtigt werden. Ein Beispiel wie die gesamte simulierte Geometie aussieht ist im Anhang 
„gesamter Kern“ zu sehen. 

Zeichnen und definieren der Geometrie:
• Edit -> Insert Mode anschalten
• Linien Zeichnen, geschlossene Linienzüge werden automatisch in Blöcke umgewandelt
• Edit -> Insert Mode ausschalten

Nachdem die Geometrie gezeichnet wurde, müssen den Geometrieelementen ihre Eigenschaften 
zugeordnet werden. Geometrieelemente sind Punkte bzw. Ecken (Vertex), Linien bzw. Kanten 
(Egde) und Blöcken. Dazu müssen zuerst Label angelegt werden. Alle Geometrieelemente mit den 
gleichen Eigenschaften bekommen dann das gleiche Label.
Die Anzeige (als Baumstruktur) für die Labeleigenschaften öffnet sich, wenn die entsprechende 
*.pbm Datei geöffnet wird. 

Neues Label anlegen:
• EdgeLabel -> „Rechte Mausttaste“ -> NewLabel 

Eigenschaften eines Label Editieren:
• Doppelklick“ auf das entspechende Labelsymbol in der Baumansicht

Einem Geometrieelement einen Label zuordnen:
• Element in der Zeichnung mit rechter Maustaste anklicken -> Properties -> Block Label -> 

auswählen

Verwendete Materialeigenschaften
Folgende Label für die verschiedenen Materialien und ihren eingeprägten Spannungen und Strömen 
wurden definiert:

„N87“ 
relative Permeabilität: 2000
Leitfähigkeit: 0.1 Siemens / m
Voltage 0V

„Leiter1“ (ohne Stromquelle, kurzgeschlossen, Leitfähigkeit entspricht Aluminium) 
(Kupfer hat eine Leitfähigkeit von 58000000 Siemens / m)
relative Permeabilität: 1
Leitfähigkeit: 35000000 Siemens / m     
Voltage 0V

„Leiter2“ (mit Stromquelle)
relative Permeabilität: 1
Leitfähigkeit: 35000000 Siemens / m
total current 1A



„Luft“
relative Permeabilität: 1
Leitfähigkeit: 0 Siemens / m
Voltage 0V

Voltage=0 bei Leiter 1 bedeutet, dass der Leiter Kurzgeschlossen ist.
total current=1A bei Leiter 2 bedeutet, daß der Leiter an einer Stelle geöffnet ist und ein Strom von 
1A eingeprägt wird.

Verwendete Randbedingungen
Folgende Label für die verschiedenen Randbedingungen wurden definiert:

„Even Symmetry“

Alle Linien  am rechten Rand haben das gleiche Label (in der Rubrik Edge Label), mit der 
Eigenschaft: tangential Field , 0 A/m, 0 deg (antisymetrisches Feld)
Dadurch wird das Feld am rechten Rand Spiegelbildlich fortgesetzt.
Das tangentielle Feld mit einer Randbedingung festzulegen heißt „Neumann condition“

„Kern Rand“

Die anderen äusseren Linien (links und oben) definieren die Aussenkanten des Magnetkerns, aus 
dem als Vereinfachung keine Feldlinien austreten sollen. Diese Aussenkanten bilden die Grenze des 
berechneten Bereichs. Eigenschaft der äusseren Linien:
magnetic potential, 0 Wb, 0 deg (auch: symetrisches Feld, hier ohne Bedeutung)
Ein bekanntes magnetisches Potential mit einer Randbedingung festzulegen heißt „Dirichlet 
condition“

Die unteren Linien auf der Rotationsachse sind per Definition symetrisch (keine Komponente in 
Richtung der Normalen) und müssen nicht nochmals definiert werden.
Die Eigenschaft von „Kern Rand“, wurde in den Beispielen von QF auch verwendet um ein offenes 
Feld (z.B. Einzelner Leiter in Luft) sozusagen „im Unendlichen“ enden zu lassen. (für die Finite 
Elemente Analyse ist immer eine geschlossene Geometrie nötig, die das Feld in einem endlichen 
Bereich begrenzt.)

Berechnung und Auswertung
Berechnung starten

• Problem -> Solve ... (oder Gleichheitszeichen-Symbol in der Symbolleiste anklicken)

Postprozessor öffnen
• Problem -> Analyze Results (oder Sonnenbrillen-Symbol in der Symbolleiste anklicken)

Auswählen der Größen, die ausgewertet werden sollen:
• View ->   Field Picture

Wieder zur Geometriedarstellung wechseln:
• Problem -> Edit Geometrie Model (oder „Geometry“ in der Baumdarstellung anklicken, 

oder das Bauklötzchen-Symbol in der Symbolleiste anklicken

Auswerten der Stromdichte I_total, RMS
• View ->   Field Picture
• color map -> current density i_total,  RMS Value, Color Grades = 200 (feinere 

Farbauflösung)



Interpretation der angezeigten Stromdichte
Die eigezeichneten Feldlinien sollen zunächst nicht betrachtet werden, und können auch 
ausgeschaltet werden (

• View ->   Field Picture -> Field Lines, beide „Häkchen“ ausschalten)

Eingeprägt wurde in den (unteren) Block „Leiter1“ 1Ampere. 
Fläche des Leiterquerschnitts: 12mm * 1mm = 12 mm^2. 
Stromdichte in A/m^2 : (1A / 12mm^2) * (1e6mm^2 / m^2) = 83000 A/m^2

Die Zahlenwert von 1A des eingeprägten Stomes im Label des Blocks „Leiter2“ entspricht der 
Amplitude (in der Hilfe als „magnitude“ bezeichnet) einer Sinusschwingung. Der RMS 
(Wirkstrom), der im Diagramm oben angezeigt wird, ist um sqrt(2) also 1,414 kleiner:
Stromdichte_RMS = 83000 A/m^2 / 1,414 = 58900 A/m^2

Das entspricht auch dem Wert, dem man der Farbtabelle im Diagram entnehmen kann.

Der Gesamtstrom im (oberen) Block „Leiter1“ ist gleich dem des unteren Leiters. Dies ist bei einer 
guten Kopplung der beiden Windungen zu erwarten. Der Strom im oberen Leiter wird durch 
Gegeninduktion hervorgerufen, sollte also das umgekehrte Vorzeichen dessen im unteren Leiter 
haben. Das Vorzeichen ist durch die Berechnung des Wirkstrom, „RMS“ (insbesondere die dabei 
erfolgende Quadrierung) verloren gegangen.

Durch die niedrige Frequenz von 100Hz (siehe Einstellung der Simulationsparameter
• Problem -> ... :Properties ...) 

ist der Strom annähernd gleichmässig verteilt (kaum Skin- und Proximityeffekte) 

Der Strom im Kern ist praktisch 0A. Das ist zu erwarten, da der Kern eine geringe Leitfähigkeit hat.

Auswerten der Stromdichte I_total, Momentanwerte
• View ->   Field Picture
• color map -> current density i_total,  RMS Value, Color Grades = 200 (feinere 

Farbauflösung)
• Phase for Momentary Values = 0 deg



Diskussion:
Die eigezeichneten Feldlinien sollen zunächst nicht betrachtet werden, und können auch 
ausgeschaltet werden (

• View ->   Field Picture -> Field Lines, beide „Häkchen“ ausschalten)

Zu erwartende Stomstärken:
Die Amplitude der Stromdichte des Gesamtstromes im unteren Block „Leiter1“ ist wie in der 
vorherigen Diskussion berechnet: = 83000 A/m^2.  Diesen Wert kann man für diesen Block auch 
aus der Farbtabelle lesen.   Die Momentanwerte werden als Amplituden ausgegeben (im Gegensatz 
zu „RMS“ im vorherigem Diagramm). Bei Phase 0 Grad hat der Momentanwert seinen positiven 
Spitzenwert (Das kann man herausfinden, wenn man andere Angaben für die Phase ausprobiert). 
Der Verlauf des eingeprägten Stroms für die AC Analyse folgt also einer Cosinusfunktion (Diese 
Tatsache ist sonst nirgends dokumentiert).

Der Gesamtstrom in der oberen, kurzgeschlossenen Windung (Block „Leiter2“) ist gleich groß, und 
hat umgekehrtertes Vorzeichen. Das ist nach dem Induktionsgesetz auch zu erwarten. 

Der Strom im Kernmaterial ist nahezu 0A, bedingt durch seinen relativ hohen Widerstand.

Kern mit Luftspalt , Sekundärwindung offen
Entspricht näherungsweise einem Sperrwandler-“Trafo“  in der Phase in der die Induktivität 
primärseitig aufgeladen wird und die sekundärseitige Diode sperrt.  Die gesperrte Diode wird 
simuliert, indem der in die Sekundärwindung eingeprägte Strom zu 0 definiert wird.

Die Geometrie ist im Wesentlichen die gleiche wie in vorherigen Beispiel. Zusätzlich wurde ein 
Luftspalt eingefügt. Leiter2 (mit Stromquelle) ist der untere Leiter. (Simulationsdaten in 
Trafo4.pbm)

Wie im vorherigen Beispiel ist die Frequenz von 100Hz (siehe Einstellung der 
Simulationsparameter:   Problem -> ... :Properties ...) 
 



Verwendete Materialeigenschaften
Gegenüber dem Vorherigen Beispiel wird die Leitfähigkeit der beiden Leiter geändert. Er entspricht 
nun Kupfer und nicht mehr Aluminium)

„Leiter1“ (offene Leiterschleife, Leitfähigkeit entspricht Kupfer) 
relative Permeabilität: 1
Leitfähigkeit: 58000000 Siemens / m     
total current 0A

„Leiter2“ (mit Stromquelle,  Leitfähigkeit entspricht Kupfer)
relative Permeabilität: 1
Leitfähigkeit: 58000000 Siemens / m
total current 1A

Auswerten der Stromdichte I_RMS
• View ->   Field Picture
• color map -> current density i_total,  RMS Value,

Wie im vorherigen Beispiel beträgt die Stromdichte (RMS) im unteren Leiter 58900 A/m^2. Der 
obere Leiter ist praktisch Stromlos, da die Windung als unterbrochene Windung definiert wurde. 
Frequenzabhängige Effekte wie Skineffekt spielen bei 100Hz in diesem Beispiel noch keine Rolle.

Die Feldlinien zeigen den Verlauf der Flusslinien bei einer vorgegebenen Phase.  
Die Phase wird eingestellt unter 

● View ->   Field Picture -> Phase For Momentary Values
Folgendes Kästchen muss angehakt sein

● View ->   Field Picture -> Field Lines -> Snapshot at given Phase
zusätzlich kann noch das Feldlinienbild bei der gegebenen Phase+90 Grad eingeblendet werden.

Standardmäßig ist die Phase 0.  Im Beispiel ist der eingeprägte cosinusförmige Strom bei Phase 0 
Grad maximal (siehe vorheriges Beispiel).  
Die farbliche Darstellung der Stromdichte erfolgt in diesem Beispiel in RMS (Effektivwert) 
während die Feldlinien einen momentanen Zustand bei Phase 0 abbilden.



An dem Verlauf der Feldlinien erkennt man, das Feld am Luftspalt ungleichmäßig wird, und weit in 
den Wickelraum hineinragt. Das Feld ist praktisch identisch zum Gleichstromfeld. 
Zum Berechnen des Gleichstromfeldes:

• Problem -> ... Properties -> Frequenzy = 0 Hz

Die Folgenden Bilder zeigen die gleiche Simulation bei verschiedenen zunehmenden Frequenzen .
• Problem -> ...: Properties -> Frequenzy = 

400 Hz 1000 Hz

Man erkennt, das mit zunehmender Frequenz die Stromdichte in der Nähe des Luftspalts stark 
ansteigt.

Bei 1000Hz (1kHz) entspricht die Eindringtiefe des Skineffekts genau dem 10-fachen der 
Eindringtiefe bei 100kHz. Die Leiter im Beispiel sind 1mm dick. Die Stromverteilung sollte also 
gerade derer entsprechen, die sich bei 100kHz für 0,1mm dicke Leiter ergibt.

Wird die Frequenz weiter erhöht...
• Problem -> ...: Properties -> Frequenzy = 

10k Hz 50k Hz

...fließt der Strom durch den zunehmenden Skineffenkt nur noch an der Oberfläche des Leiters. 
(Änderung des Massstabes für die Farben berücksichtigen!). Besonders ausgeprägt ist der 
Skineffekt im oberen Leiter. Dort fließen nur Wirbelströme, da der Leiter ja als Stromlos definiert 
wurde. Der Skineffekt kann durch den Energieerhaltungssatz erklärt werden. Der Hochfrequente 



Strom versucht so zu fließen, das das erzeugte Feld möglichst klein ist (gespeicherte Energie 
minimal). Das Feld wird aus dem Volumen des Leiterinneren herausgedrängt. Genauso drängt der 
Strom im unteren Leiter das Feld in den Luftspalt zurück (vergleiche Bilder bei f=1kHz und bei 
f=10kHz). 
Dieser Effekt heißt Proximity Effekt (Annäherungseffekt) , wenn Leiter mit entgegengesetzten 
Stromrichtungen sich gegenseitig beeinflussen

Der Kommutierungsvorgang im Sperrwandler
Hinweis: Primär und Sekundärstrom lässt sich komplett über Fouriertransformation in einzelne 
Sinusförmige Anteile plus DC Anteil zerlegen. Mutmasslich ist die physikalische Funktionsweise 
der Kommutierung (Unterbrechung des primärseitigen Stromes durch z.B. einen Mosfet usw.)  für 
die Berechnung der Verluste unerheblich. Ob sich die zu betrachtenden Ströme letztlich durch eine 
externe Schaltung ergeben oder einfach fest eingeprägt werden, spielt keine Rolle, wenn sie in 
beiden Fällen gleich sind. 

Kommutierungsvorgang ist Hochfrequent, primär sekundär gegenphasig. Überlagertes DC Feld (im 
Luftspalt gespeicherte Energie) spielt für die Verluste bei hohen Frequenzen keine rolle (nur diese 
HF-Verluste sollen berücksichtigt werden, bzw. ihr Anteil bestimmt werden) Während der 
Kommutierung bleibt das gespeicherte Feld, und damit der gesamte I*N praktisch konstant.
Modellierung mit gegenphasigen Strömen in den beiden Wicklungen (+- 1A) Betrachtung im 
Nullduchgang (Sozusagen stellvertretend für die weiteren höher- und niederfrequenten Anteile).

Dargestellt Primärstrom rot, Sekundärstrom blau 

Prim.str. Geht auf 0, sekundär steigt auf vorherigen maxwert.

RMS Verluste multiplizieren mit effektivem Tastverhältnis (z.B. Kommutierungsflanke 
entsprechend  10Mhz -> 0,1us zu Taktperiode 10us : effektives tastverhältnis 0,01

Das Simulationergebnis für folgende Parameter:
Freq.: 10kHz (Entsprechend 1Mhz für eine Leiterdicke von 0,1mm) 
Eingeprägter Strom im oberen Leiter 1A, im unteren: -1A
Phase: 90° d.h. Nulldurchgang
Sonst gleiche Materialeigenschaften wie im vorherigen Beispiel.
Momentawerte RMS

Kommutierung

überlagerter DC-Strom



Der Momentanwert der eingeprägten Ströme ist 0A. Trotzdem fließen in diesem Moment sehr 
starke Ströme im Leiter. 1A sinusförmigem Strom entspricht im verwendeten Leiterquerschnitt wie 
in den vorherigen Beispielen besprochen einem Spitzenwert der Stromdichte von 0,83*10^5A/m^2.

Wenn die Momentanwerte der eingeprägten Ströme 0A betragen, können die fließenden Ströme nur 
noch Wirbelströme sein. Ihr Momentanwert übersteigt teilweise deutlich die Amplitude des 
eingeprägten sinusförmigen Stromes.
Die tatsächliche Kommutierungsphase dauert höchstens 100ns, entsprechend 10MHz. Alle 
besprochenen Effekte sind also tatsächlich noch wesentlich ausgeprägter.  

An der Darstellung der RMS Stromdichte erkennt man, das wesentlich mehr Strom an den 
gegenseitig zugewendeten Oberflächen fließt als im restlichen Leiter. Dies kommt vom 
Proximityeffekt, der später untersucht werden soll. 

Proximityeffekt

Trafo3.pbm 

oben kurzgeschlossen, unten jeweils 1A in Reihe, frequenz 20khz.

Aufintegrierte Werte anzeigen (z.B. Gesamtstrom)
Wenn man den Gesamtstrom durch einen Leiter wissen will (und nicht nur die Stromdichte) kann 
mann sich aus dem Simulationsergebnis aufintegrierte Werte anzeigen lassen.

• View -> Integral Values



mit einem Doppelklick auf dein Block (z.B. Leiter) kann man diesen Auswählen und dann 
verschiedene Werte (z.B. gesamter Wirbelstrom; engl. EddyCurrent). Auch geometrische 
Eigenschaften wie z.B. das Volumen des Kerns können angezeigt werden (bitte beachten, daß nur 
ein Viertel des Kerns simuliert wird, das reale Kernvolumen also 4 mal so groß ist (siehe Anhang 
„Gesamter Kern“).

Untersuchung des Proximityeffekts an einer unendlich langen, von Ferrit (blauer Block oben und 
unten) eingeschlossenen Spule. Rechts und links befinden sich 
symmetrische Grenzen.

Zunächst eine Erkenntnis bei DC-Strom

 Die obige Simulation zeigt die Stromverteilung von 4 in Serie geschalteten Kupferröhren bei einer 
Frequenz von 0,01Hz. Das Simulationsergebnis entspricht praktisch dem Ergebnis bei Simulation 
eines Gleichstromes. Trotzdem ist der Strom nicht gleich verteilt. Dies liegt an den unterschiedlich 
langen Strompfaden innerhalb der simulierten Kupferröhren. Je kleiner der Radius der Röhre, um so 
geringer der Widerstand. Daher ist die Stromdichte auf der zur Rotationsachse (untere waagrechte 
Simulationsgrenze) zugewandten Seite der Röhren jeweils am höchsten. Je kleiner der Durchmesser 
der Röhre ist, um so größer ist der Unterschied zwischen der Außenseite und der Innnenseite.

Weitere Ideen für Untersuchungen:



Anhang 

Gesamter Kern
Darstellung des gesamten Kerns mit Wicklungen, zusammengesetzt aus 4 gleichen, gespiegelten 
Feldlinienbildern.
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